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GRAIN ANALYSIS WITH GRAINFIND 

With GeoDict’s GrainFind module, individual grains can be identified in structures 
where the grain boundaries are previously unknown. For each identified grain, an 

individual best-fit shape is computed and its orientation in the structure is obtained. 

In this way, simulations on the structure are possible which were impossible before, 

such as simulations of mechanical properties which depend on grain orientation. 
Furthermore, the structural information gained can be used to generate similar 
structures using the GrainGeo module – so-called digital twins of the structure can be 

modelled.  

Possible applications are in the area of electrochemistry, where grains in battery 

electrodes can be identified, or in Digital Rock Physics, where information about 
individual grains fosters a thorough understanding of the rock structure. GrainFind 

can also be used to characterize particles in particle filtration applications. 

 

For successful GrainFind runs, the parameters for the module must be chosen 
carefully. The built-in default values cannot be set to deliver the best possible results 

for all applications. Best practice is to carry out a parameter study for the solver 
parameters at the beginning of the analysis. 

To start GrainFind, select Analyze → GrainFind from the menu bar.  

 

Additional to the grain identification, it is also possible to Identify Binder (AI) using 

machine learning technologies. Please note that for this feature a special license is 
required. 

Identify Grains 
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Moreover, the grain size distribution can be estimated through the Estimate Grain 

Diameters option.  
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IDENTIFY GRAINS 

With GrainFind - Identify Grains, individual 
grains are identified and analyzed in a given 
structure. The analysis includes the 

determination of grain volume, sphericity, and 
the orientation of the grains. Based on the 

statistical properties of the identified grains, a 
digital twin of the structure can be created in 
GrainGeo.  

Select Identify Grains from the pull-down 
menu in the GrainFind module section at the 

bottom-left of the GUI. The parameters needed 
by the GrainFind algorithm can be entered in the 
Identify Grains dialog, that is opened by 

clicking the Options’ Edit … button. Before 
describing the needed parameters in detail, we 

investigate the method behind the identifying 
algorithm. 

HOW DOES IDENTIFY GRAINS WORK? 

The grain identification process in GrainFind is mainly based on the Watershed 
algorithm (WA, https://en.wikipedia.org/wiki/Watershed_(image_processing)) that 

is widely used for the segmentation of image data. The challenge of identifying 
individual grains in a connected structure can be performed through a segmentation 

of the structure. The algorithm for the grain identification consists of the following 
steps: 

1. Converting the image into a distance map using the Euclidean Distance 
Transform (EDT). 

2. Identifying local maxima in the distance map and converting them to grain seeds 
as starting point for the WA. 

3. Identifying individual grains by a grain-border determination through the WA. 

4. Post-processing of the identified grains. 

a. Handling of grain fragments 

b. Handling of boundary grains 

Only the parameterization of the watershed transform algorithm (choosing a minimal 
grain diameter) and the post-processing (reconnection of grain fragments, boundary 

grain handling etc.) require user input. The complexity of the algorithm – such as the 
EDT - is hidden “under the hood”.  

The main steps to run the watershed algorithm are:  

1. Select the material to be analyzed 

2. On the chosen material, the EDT is carried out as a preparation for the watershed 
transform 

3. The watershed transform is conducted based on the EDT.  

https://en.wikipedia.org/wiki/Watershed_(image_processing)
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In many cases, the result of the watershed transform is enough to identify the grains. 
Otherwise, further steps are required. 

 

EUCLIDEAN DISTANCE TRANSFORM 

For a given material in a structure, a distance transform computes the distance to the 

boundary of the material for every point (voxel) in the structure 
(https://en.wikipedia.org/wiki/Distance_transform). Points close to the material 

boundary get assigned low distance values, whereas points deeper in the material get 
assigned larger distance values. The larger the value of the Euclidean Distance 

Transform, the larger the sphere which can be inscribed in the structure. The EDT is 
therefore a measure for the grain sizes. 

In the figure below, the EDT is illustrated in a simple 2D example. On the left side, a 

structure of several overlapping grains is shown. On the right, the resulting EDT is 
shown. Points close to the material boundary are marked in green, and points distant 

to the material boundary are marked in red.  

 

 

 

 

 

 

 

Points distant from the 
material boundary 

→ high distance values 

Points close to the 
material boundary 

→ low distance values 

Euclidean Distance Transform (EDT) 

Grain Material Euclidean Distance to the material border 

Structure 

1 32

https://en.wikipedia.org/wiki/Distance_transform
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WATERSHED ALGORITHM 

The watershed algorithm (WA) is a segmentation algorithm commonly used in image 
processing. The WA is based on the EDT. Grain seeds are placed in the local maxima 

of the EDT, and in those seeds, grains start to “grow”. In the growing process, grain 
boundaries are formed as soon as grains touch. 

The concept behind the watershed algorithm transform can be understood more easily 

in a 2D example. In this representation, the EDT can be regarded as a topographical 
relief where high values represent valleys and low values represent peaks. This 

topography is continuously “flooded with water”, starting from the deepest valleys. 
As soon as the water from neighboring valley begins to mix, a dam is created 

(corresponding to the grain boundary). The result is a topography with water-filled 
valleys and dams that separate them. The identified valleys represent the grains and 
the dams that separate them denote the grain boundaries. 

In the figure below, the progression of the watershed algorithm is illustrated. On the 
left side, the topographical relief corresponding to the EDT is shown where the grain 

seeds (valley bottom) are marked in red. This topography is successively flooded with 
water, and dams are formed between adjacent valleys. 

 

 

Known information about the grain space, i.e. the minimal grain diameter, can be 

used to adjust the results of the Watershed Algorithm. 

 

SPHERICITY PARAMETERS 

While there are many definitions of sphericity, the two sphericity indices given in the 
GrainFind output are those defined by Sheppard (2006) (optional) and Krumbein 

(1941). See the references on page 48. 

Based on Sheppard, the sphericity of a pore 𝑃𝑆 is defined as the ratio of the inner 

radius 𝑅𝑖 of a grain to its equivalent radius 𝑅𝑒. 

𝑃𝑆 =
𝑅𝑖

𝑅𝑒

(1) 

The equivalent radius 𝑅𝑒 is the radius of a sphere with the same volume as the grain. 

The inner radius 𝑅𝑖 is the radius of the largest sphere which fits into the grain. The 

inner radius can be computed based on the EDT. 



Identify grains – How does identify grains work? 

GeoDict 2023 User Guide  5 

Sphericity values range between 0 and 1. The more the grain resembles a sphere, 

the higher is the sphericity value. A value of 1 marks a perfect spherical grain. 

 

To calculate sphericity based on Krumbein, three principal axes (a, b, c) are measured 

by fitting an ellipsoid into the grain. The Krumbein sphericity 𝑃𝐾 is then calculated 

using the length of the axes 

𝑃𝐾 = √
𝑏𝑐

𝑎2

3

(2) 

where a is length of the longest axis, while b and c are the lengths of the two 

shorter axes.  

Analogously to the Sheppard sphericity, the values for the Krumbein sphericity 

range between 0 and 1, with 1 characterizing perfectly spherical grains.

Grain geometry
Inner radius
r=2 voxel

Equivalent radius
r=2.26 voxel

Illustration of a 2D grain geometry and its inner and equivalent radii.  
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SETTING PARAMETERS FOR GRAIN IDENTIFICATION WITH GRAINFIND 

In the Identify Grains dialog window, enter the Result File Name (*.gdr) under 
which the results are saved in the chosen project folder. 

The Identify Grains dialog consists of three tabs. In the Grain Segmentation tab the 
parameters for the segmentation can be entered. In the next tab the Output Options 

can be defined and in the Constituent Materials tab material specific properties like 
the density can be set. 

The two structures used to explain these parameters are shown below: A structure 

with sintered grains, generated with GrainGeo (Sinter), and a simple structure with 
overlapping spheres (Spheres), generated with GadGeo.  

GRAIN SEGMENTATION 

The parameters under the Grain Segmentation tab are grouped into four panels: 

Initialization, Grain-Fragment Reconnection, Domain-Boundary Options, and 
Grain-Shape Analysis.  

Sinter Spheres 
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INITIALIZATION 

The parameters in the Initialization panel define the basis for the analysis. The 

structure to be evaluated is chosen through the Input Mode and the material to be 
analyzed is selected through Material to Analyze.  

For the Input Mode, three options are available:  

▪ Use the structure currently in memory (Use Current Structure) 

▪ Import already segmented data from an index-image file *.g32 or *.leS (Load 

Presegmented Data) 

▪ Use the currently loaded *.g32 file (Use Loaded Index Image) 
 

The initialization (the watershed algorithm) might be time consuming for large 

structures. Thus, the options Load Presegmented Data or Use Loaded Index 
Image are useful when performing parameter studies with GrainFind, where the 

initialization is kept unchanged while other parameters are varied. So, the 
segmentation results from previous GrainFind runs can be used. 

Use Current Structure 

When Use Current Structure is used as Input Mode, the parameters for the 

watershed segmentation need to be defined. The Minimal Grain Diameter defines 
the minimal size an individual grain must have for the GrainFind analysis. This 
parameter determines which grains to keep and which grains to neglect or merge with 

others. If smaller grains exist which are connected to larger grains, these grains are 
merged. Single grains (i.e. which are unconnected to other grains) with a diameter 

smaller than Minimal Grain Diameter are neglected. 

 

The Minimal Grain Diameter can be entered in unit of voxels or in unit of meters. 

The default value of 2 voxels works well in most cases and should therefore be left 
unchanged if a good estimation is unknown. The unit of the Minimal Grain Diameter 

can be changed through the pull-down menu next to the value box.  

 

The effect of the choice for Minimal Grain Diameter is illustrated below. The figures 

show the result of the initialization step (of the watershed algorithm). The original 
structure contains spheres with diameters 100 µm, 60 µm, and 20 µm, and some of 

the grains overlap.  
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With Minimal Grain Diameter set to zero, all five spheres are identified as single 
grains and labelled in different colors. When setting the Minimal Grain Diameter to 

25 µm, the single 20 µm sphere (top left) is neglected, while the 20 µm sphere 
connected to the larger sphere is merged. Analogously, for a choice of 65 µm, only 
one single merged grain is kept while the smaller spheres are neglected. The effect 

of removing small objects from the structure is suitable for denoising. 

Under Material to Analyze, the user defines the part of the structure to be 
considered. Either the complete structure can be analyzed (All Solid Materials), an 
individual material can be selected (Chosen Material) or a choice of material IDs 

can be made (Chosen Material IDs). With Chosen Material IDs, one or multiple 
IDs can be chosen, which are then combined and analyzed as one single material. 

 

d = 100 µm 

overlap: 4 µm 

d = 20 µm d = 60 µm 
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Load Presegmented Data 

For Load Presegmented Data, the data needs to be available as a GeoDict index 
image. An index image is a voxel image, where each voxel is assigned to an object 

ID. Such an image can e.g. be obtained from a previous GrainFind run. The file 
containing this index image can be selected with the Browse… button (*.g32 and 
*.leS files are allowed). 

 

The difference between the *.g32 and *.leS formats is that *.g32 is a binary format, 
which produces comparatively smaller files but is not human readable, and *.leS is 

an ASCII-format which is human-readable, but produces larger files. Furthermore, 
loading a *.g32 file into GeoDict is much faster than loading a *.leS file. Therefore, 
we recommend to use the *.g32 option when possible. 

GeoDict index images contain no material information. Therefore, a Pore Material 
and Grain Material must be selected. The material info is used in the Results Viewer 

to compute the grain mass and the moment of inertia. 

Use Loaded Index Image 

This mode works analogously to Load Presegmented Data. The only difference is 
that the index image must be already in memory. This is especially useful when an 
index image is created in GeoDict, but not yet saved to a file.  

 

GRAIN-FRAGMENT RECONNECTION 

In some cases (e.g. for complex grain shapes), the watershed algorithm in step 1 

tends to over-segment the structure. This means, that some grains are identified as 
multiple grains (“Fragmented Grains”) when, in fact, they may be a single grain with 

a complex shape. With Reconnect Fragmented Grains, it is possible to handle this 
over-segmentation by merging grains depending on the size of their shared interface.  

Activate the checkbox Reconnect Fragmented Grains to merge connected grains 

depending on the value chosen for Interface Threshold. 
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The probability that two grain fragments belong to the same grain is measured with 

the interface ratio. This interface ratio compares the interface area of two touching 
grain fragments with the surface area of the grain fragment with the smaller surface. 

interfaceratio =
interface of the touching grain fragments

min(surfaceofgrain1, surfaceofgrain2)
(3) 

For the computation of the interface ratio, the grain surfaces and interfaces need to 

be computed. The surface area estimation is based on MatDict’s “Estimate Surface 
Area” (see Ohser, Mücklich [3]).  

If the interface ratio is larger than the percentage chosen for the Interface 

Threshold, the two grain fragments are merged. For example, if the Interface 
Threshold is set to 14%, then all grain fragments with an interface ratio larger than 

14% are merged. 

 

The value for the Interface Threshold must be chosen carefully depending on the 

structure. The smaller the threshold, the more grains are merged. In the figure below, 
observe the effect of different choices for the Interface Threshold. For the extreme 

value 0 %, all connected grains fragments are merged to one. For a value of 5 %, 
several large and complex grains are detected in the structure, and for a value of 
20 %, many small grains are detected. The choice of the Interface Threshold must 

be adapted to the expected grain shapes for the structure type. To help the user 
finding the correct Interface Threshold for the structure, the Reconnection 

Indicators histogram under the Results → Plots subtab in the Result Viewer can be 

used.  

 

 

DOMAIN-BOUNDARY OPTIONS 

In the Domain-Boundary Options panel, the handling of boundary grains is defined. 
When Remove Grain Fragments at Domain Boundary is checked, all grains 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2023&heading=EstimateSurface
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2023&heading=EstimateSurface
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touching the domain boundary, after the initialization and the grain-fragment 

reconnection are done, are removed.  

This is especially useful if the goal is to estimate the grain shapes and sphericity 

parameters in the structure: Boundary grains which lay not completely in the 
structure might lead to wrong estimates for the grain shapes. Nevertheless, also 

removing the boundary grains influences the results. See page 42 for an example and 
further explanations. 

 

When Remove Grain Fragments at Domain Boundary is unchecked, the 
Periodicity options become available. By checking the X-, Y- or Z-Direction 

checkboxes, the structure is treated as periodic in the chosen direction(s) before the 
segmentation.  

This option should only be chosen if the investigated structure is really periodic, 

otherwise it might lead to strange results (with grains which are treated as connected 
but are distant from each other in reality). Otherwise, when Periodicity is not chosen 

in a direction, the structure is analyzed with symmetric boundary conditions in this 
direction. This is the best option for estimating the shape of boundary grains.  

 

 

GRAIN-SHAPE ANALYSIS 

After the grain identification step (defined by the parameters under Initialization, 

Grain-Fragment Reconnection and Domain-Boundary Options), the shape of 
the grains is analyzed. This analysis is done with the help of best-fit shapes.  

There are three options available for the Grain-Fit Shape: Either an Ellipsoid, a 
Short Elliptical Fiber or a Box can be chosen. The Grain-Fit Shape should be chosen 
depending on the grain shape appearing in the analyzed structure.  

Material to analyze Structure after segmentation Structure after boundary 

grain removal 
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In the figure below, the results of the Grain-Shape Analysis are shown. These 
visualizations are loaded from the Results Viewer of the *.gdr result file (under the 

Grain Visualization tab), see page 16 for more information.  

On the left, the structure after Boundary-Grain Removal is shown. In the middle, the 
grain-fit shapes are shown (here, Ellipsoid was chosen as the Grain-Fit Shape) and 

on the right, a comparison between the identified grains (red) and their fit shapes 
(green) is shown, where the matching voxels are shown in grey.  

 

 

OUTPUT OPTIONS 

Under the Output Options tab, some additional results to be computed and saved 
can be chosen. They are displayed later for visualization in the Result Viewer under 

the Grain Visualization tab. Some of these options need an additional computing 
effort and are unchecked by default. 

Load Grains from Step 3 
(Result of Boundary Grain 

Removal) 

Load Grain Fit Shapes Load Comparison of Segmented 
Grains and their Fits 
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▪ Choose Save Grain-Size Distribution (Volume-Equivalent Diameter) as 

*.gsd to save the computed grain size distribution as a volume field. This 
information can be used e.g. for visualization of the volume field of the Volume-
Equivalent Diameter (see page 26) or for further analysis with Python. 

▪ With Save Inscribed-Sphere Diameters and Sheppard Sphericities checked, 
the diameter of the inscribed sphere for every grain is calculated as volume field 
and saved. The results of this volume field are saved in the *.gsd file and can be 

loaded with it. The Sheppard sphericities and the inscribed sphere diameters can 
be found in the Result Viewer (Results – Plots – Sphericities tab and Diameters 

tab, see page 18). Both options need additional computing effort and are 
unchecked by default. 

▪ Save Grain-Orientation Distribution as *.gof to use the orientation 
information in simulations or for later analysis. For example, when predicting 

mechanical properties with ElastoDict, anisotropic material properties can be 
assigned depending on the grain orientation. 

▪ The checked-by-default option Save Comparison of Segmented Grains and 
their Fits as *.gdt is useful to evaluate the quality of the computed Grain-Fit 
Shapes (Ellipsoids, Short Elliptical Fibers or Boxes, see page 11). A good 

accordance of the grain fit shapes and the identified grains is important as a basis 
for generating good digital twins of the structure with GrainGeo Create – Load 
GrainFind Result (See page 29). 

▪ With Save Euclidean Distance Transform per Grain as .*dst, the Euclidean 
distance transform for every grain is calculated individually and the result is saved 
in one single *.dst file. This option needs additional computing effort and is 

unchecked by default. 

▪ The resulting grain index image is saved by default in the binary *.g32 format. 
With Save Grain Index Image as *.leS, it can be additionally saved as an ASCII 

file. This format takes more space and needs longer to write and load into GeoDict, 
but it is human-readable and can easily be imported into other software.  
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Choosing Histogram Weighting as Volume, Surface or Number changes the 

values on the y-axis of the resulting histogram plots. Then, either the grain volume 
probability, the grain surface area probability, or the grain count probability is shown. 

The Histogram Weighting can be changed in the result viewer after the simulation 
has been run.  
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CONSTITUENT MATERIALS 

In the constituent materials tab, a material from the GeoDict material database can 
be assigned to each material phase in the structure. Alternatively, manual materials 

can be defined. In GrainFind-Identify Grains, the density of the grain materials is used 
to compute the mass and moment of inertia of the grains. For further information 
about material in GeoDict, see the GeoDict Material Database handbook of this User 

Guide 

 

 

The Constituent Materials tab is only available if Use Current Structure is chosen 

as input under the Grain Segmentation tab. In the other cases, no material IDs 
exist to which the materials could be assigned, and the tab is greyed out.  

 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MaterialDatabase&release=2023
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GRAIN IDENTIFICATION RESULTS 

After performing the GrainFind analysis, the results are saved in a GeoDict result file 
(*.gdr) with the given Result File Name. When the analysis is finished the Result 

Viewer opens automatically. For more information about the GeoDict Result 
Viewer, refer to the Result Viewer handbook of this User Guide 

By clicking Load Structure, the analyzed structure can be imported into the 
Visualization area of the GeoDict GUI. Observe the dot at the right side of the Load 
Structure button: a green dot means that the structure currently in memory 

corresponds to the results shown in the Result Viewer. A red dot means that the 
structure does not correspond to the results. 

The Result Viewer contains several tabs. Input Map, Log Map, and Post Map 
contain the parameters concerning the GrainFind process. The Log Map contains 
information about the identification process, as e.g. the runtime and the used 

computer. The Post Map contains all information about the post-processing in the 
results viewer, as e.g. the chosen plots and their parameters. Only the Input Map is 

shown below in detail, the other two are structured analogously. The Result tab 
shows the report of the run as well as several plots, which are described in the Results 
section. In the Grain Visualization tab additional result files can be loaded 

depending on the choice made in the Output Options. A video of single grains and 
their fit object can be generated in the Create Videos tab. The Metadata tab 

contains some meta information about the results file.  

At the bottom of the Result Viewer, several buttons are available: 

◼ With Manage Data by choosing Clean Up/Pack either old results files can be 
deleted (Clean Up) or the results can be packed to a *.zip file. Clicking Rename 

allows to change the name of the *.gdr file. 

◼ With Load Input Map, the parameters in the input map are loaded in the GUI 

and can be used to analyze different structures. 

◼ Export data: 

◼ Analyze and plot computation results in Microsoft Excel®. Check out the 

GeoDexcel and Result Viewer handbooks for more information. 

◼ Analyze the results in MATLAB® using GeoDict’s MATLAB® interface GeoLab by 

clicking Matlab. All information included in the results file is loaded into 
MATLAB® automatically. 

◼ Save the information in the result file in *.html format by clicking Store As 

HTML. 

◼ Save Plots to save images for all plots of the Results Plots subtab at once. 

◼ Save the Input Map as Python file to re-execute the run as macro with the 
same settings. 

◼ Close the results file by clicking Close. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=GeoDexcel&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ResultViewer&release=2023
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INPUT MAP 

The Input Map contains a table with all chosen input parameters for Identify 
Grains. For example, it is shown that Reconnect Fragmented Grains was 

enabled (true), and that Ellipsoid was selected as the Grain-Fit Shape. 

 

RESULTS 

The Results tab is the central point for the analysis of the identified grains. It is 
grouped in three subtabs: Report, Plots and Map. The Report subtab shows 

statistics about the identified grains. The Plots subtab contains different plot options 
for the analysis of the results. The Map subtab contains all resulting data from the 
Identify Grains run. This data is the basis for the tables in the Report subtab and 

for the plots in the Plots tab. The Report subtab for the example is shown below.  
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PLOTS 

Under the Plots tab, several plots visualize the results. These plots are grouped in 13 

tabs which show the relationship between grain parameters: Scatter Plot, 
Threshold by Scalar Value histogram, Volume histogram, Diameters histogram, 

Perimeter histogram, Sphericities histogram, Aspect Ratio histogram, Surfaces 
and Contacts histogram, Mass histogram, Moment of Inertia histogram, 
Coordination Number histogram, Orientation polar plot and Reconnection 

Indicators histogram. 

 

Settings for these plots can be selected in the panel at the left side of the Plots 
subtab. After changes, click Apply… to use the new values. The changes are also 
applied to the table under the Report subtab. 

For the Threshold by Scalar Value histogram, the threshold parameter must be 
selected under Threshold by Scalar Value on the left (See page 23 for further 

explanations). The default is Threshold by Volume. 

In the example below, observe in the Scatter Plot that all identified grains in the 
structure are nearly spherical (Krumbein Sphericities close to 1). Nearly all grains 

have an equivalent diameter around 12.5 µm, except of two outliers. 

 

 

 

 

 

Collapse and expand 
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The plots Scatter Plot and Orientation distinguish between four possible shapes for 
the Ellipsoids that are fitted into the grains: Flat Bar, Prolate Spheroid, Oblate 

Spheroid and Sphere.  

 

 

 

 

 

 

◼ An ellipsoid is formed as a Flat Bar, if all three diameters differ 
much from each other.  

◼ A Prolate Spheroid has one bigger and two similar smaller 
diameters. Thus, it can be compared to a cigar. 

◼ The two bigger diameters of an Oblate Spheroid are similar. Thus, 

it can be compared to a disk. 

◼ For a Sphere, all three diameters are similar. 
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For the shape Short Elliptical Fiber the following four shapes are considered:  

 

 

 

 

 

 

 

◼ A fiber is Elliptical, if the two diameters are different. 

◼ It is Circular, if the two diameters are the same.  

◼ An Elliptical Stub has at least one diameter larger 
than the length and the diameters are different. 

◼ The Circular Stub is the same as above, but with 

equal diameters.  

 

 

For the shape Box the following shapes are considered:  

 

 

 

 

 

 

 

◼ If the all three lengths differ a box is called Flat Bar. 

◼ For a Rectangular Bar the two shorter lengths are equal. 

◼ For a Rectangular Disk the two larger lengths are equal. 

◼ If all three lengths are equal the box is a Cube. 
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Histogram Weighting and Histogram Plot Type 

The values on the y-axes of the histograms in all plots (except Scatter Plot, 
Threshold by Scalar Value, Orientation and Reconnection Threshold) can show 

Count Probability (weighting by Number), Area Probability (weighting by Surface) 
or Volume Probability (weighting by Volume), as a Relative or Cumulative plot. 
This can be set by adjusting the Histogram Weighting and Histogram Plot Type.  

The Area (or Surface) Probability is defined by computing the surface area of each 
segmented grain (using the same algorithm as in MatDict’s Estimate Surface Area 

command) and then weighting the grains by that value. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Scatter Plot 

Under Scatter Plot, the variables for the x- and y-axis in the scatter plot can be 
chosen. More on the variables can be found in the next section. 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=MatDict&release=2023&heading=EstimateSurface
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Threshold by Scalar Value 

In Threshold by Scalar Value, several options for thresholding the structure 

depending on the results are available. The choice of the Scalar Value affects the 
plot that is created under the Plots - Threshold by Scalar Value subtab. 
Additionally, a structure containing the materials of the thresholded grains will be 

created, that can be accessed through the Grain Visualization tab → Load Grain-

Type Structure → click Load *.gdt or Load *.gad button. 

The following Scalar Values are available for thresholding: 

▪ Equivalent Diameter: the diameter of the volume-equivalent sphere. 

▪ Inner Diameter: the diameter of the largest sphere that can be inscribed into 
the grain.  

▪ Shortest Fit Diameter: the shortest diameter of the shape (ellipsoid, box, short 

fiber) fitted onto the grain.  

▪ Intermediate Fit Diameter: the intermediate diameter of the shape (ellipsoid, 
box, short fiber) fitted onto the grain. 

▪ Longest Fit Diameter: the longest diameter of the shape (ellipsoid, box, short 

fiber) fitted onto the grain. 

▪ Perimeter: three diameters are needed to define the ellipsoid fitted into the 
grain. The perimeter is the shortest perimeter around this ellipsoid, which means 
it is computed as the perimeter of the ellipse formed from the two smallest of 

those three diameters. 

▪ Krumbein Sphericity: a measure for the sphericity based on the grain fit (see 
page 4). 

▪ Sheppard Sphericity: the diameter of the inscribed sphere divided by the 
diameter of the volume-equivalent sphere (see page 4). 

▪ Aspect Ratio: the ellipsoid fitted into the grain is defined by three diameters. 
The aspect ratio is the shortest diameter divided by the largest of those 

diameters. 

▪ Surface Area: surface of the grains estimated by an algorithm based on 
MatDict’s Estimate Surface Area command (see Ohser, Mücklich [3]). 
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▪ Surface-to-Volume Ratio: estimated surface of the grain divided by the 

volume of the grain. 

▪ Surface Smoothness: the surface of a fitted ellipsoid divided by the estimated 
surface. Usually the estimated surface is larger than the surface of the fitted 
ellipsoid. Hence, the surface smoothness is usually below 1. Only if the shape of 

the grain is very ellipsoidal, then the surface estimation might be a little smaller 
than the surface of the fitted ellipsoid. 

▪ Cut-Surface Ratio: the interface of the grain with the domain boundary over 
the remaining surface of the grain. The Cut-Surface Ratio measures how much 
of the grain surface is part of the domain boundary. It is a measure for the quality 

of boundary grain. For example, a Cut-Surface Ratio of 1 means that the 
interface of the grain with the domain boundary is as large as the remaining 
surface of the grain. 

NOTE that the domain boundaries, that were set to be periodic, do not contribute 
to the interface of the grain with the domain boundary. Particularly, if all domain 

boundaries are set to be periodic, the cut-surface ratio will always be zero. Also, 
if Remove Grain Fragments at Domain Boundary was activated (page 10), 
then the cut surface ratio is zero, too, because there will be no grains left that 

have an interface with the domain boundaries. 

▪ Mass: the mass of the grains is computed based on their volume and the density 
of the grain material. 

▪ Moment of Inertia: the moment of inertia is computed based on the grain 
shape and the density of the grain material. 

▪ Volume: the volume of the grain, simply determined by the number of voxels 
the grain contains. 

▪ Coordination Number: the number of contacts of a grain to other grains. 

NOTE that the choice of Inner Diameter and Sheppard Sphericity are only 
available if the option Save Inscribed-Sphere Diameter and Sheppard 

Sphericities was checked in the Output Options of the grain-identification options 
(page 13).  

 

The Number of Bins defines how many bins the histogram Threshold by Scalar 
Value has. 

 

The following Thresholding Methods are available: 

▪ k-Means: uses the k-Means algorithm to find thresholds for the chosen Number 
of Grain Types. 

▪ Otsu: uses the Otsu algorithm to find thresholds for the chosen Number of 
Grain Types. 
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▪ Manual: define your own thresholds by writing a comma-separated list of 

thresholds into Threshold(s). They will then be applied to the computed grain 
index image. 

GSD Field Choices 

The GeoDict size distribution (GSD) files allow to visualize the various scalar grain 

properties that are a result of the grain identification. 

See the options for the configuration of a GeoDict size distribution (GSD) file in the 
figure below. For every chosen grain property, a volume field is created containing 

the 3D distribution of this grain property. These volume fields are saved together in 
a GSD file (*.gsd), which can be accessed through the Grain-Visualization tab → 

Load Grain-Size Distribution → click Load *.gsd button.  

For example, by choosing Equivalent Diameter and Surface, the *.gsd file will 
contain two volume fields: one with the size distribution of the diameters of volume-

equivalent spheres, and one with the distribution of the grain surface.  

The same measures for assembling a customized size distribution are available as for 

the thresholding (see page 23). 

Histogram Bin Sizes 

The bin sizes used in the plotted histograms can be customized.  
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In general, it is possible to choose between: 

▪ Number of Bins: choose how many bins the histogram should have. 

▪ Bin Size in Units: choose the bin size for the histogram using the value in the 
appropriate unit (m, µm, nm, etc.). 

▪ Bin Size in Voxels: choose the bin size for the histogram using the value 

measure in voxel lengths. 
 

As the different histogram plots show different results, only those choices are 

available which make sense for the corresponding plot.  

◼ The selection made under Volume changes the bin size for the plot under the 

Volume tab. 

◼ The selection made under Diameters changes the bin size for all plots under the 
Diameters tab. 

◼ The selection made under Perimeter changes the bin size for the plot under the 
Perimeter tab. 

◼ The selection under Sphericity and Aspect Ratio cannot be changed, this affects 
the bin size for the plots under the Sphericities tab and the plot under the Aspect 
Ratio tab . 

◼ The selection made under Surface and Contact changes the bin size for the 
Surfaces and Contacts plots under the Surfaces And Contacts tab. 

◼ The selection made under Surface-to-Volume Ratio changes the bin size for the 
Surface-to-Volume Ratios plot under the Surfaces And Contacts tab. 

◼ The selection made under Surface Smoothness changes the bin size for the 

Surface Smoothnesses plot under the Surfaces And Contacts tab. 

◼ The selection made for Mass changes the bin size for the Mass histogram. 

◼ The selection made for Moment of Inertia changes the bin size for the Moment 
of Inertia histogram. 
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GRAIN VISUALIZATION 

The Grain Visualization tab is used to import structures and computed volume fields 
which illustrate the grain identification process and its results.  

There are several options available for the visualization of the different steps of 
Identify Grains and for the evaluation of the quality of the results. Some options in 
the Grain Visualization tab might be unavailable, depending on the parameters 

chosen in the Identify Grains dialog (Output Options tab, see page 12). The 
visualization options are grouped into panels. 

GRAIN-SEGMENTATION RESULT 

In the first panel, several options for the analysis of the identified grain shapes are 
available. With Load Grains as Index Image, all identified grains are assigned to a 
unique 32-bit color and can be investigated in the Visualization area. The 2D-view of 

*.g32 files is particularly suited for visual analysis of the correct segmentation. 

The Load Grain-Size Distribution and the Load Grain-Orientation Distribution 

are greyed out when these two options have not been previously checked under the 
Output Options tab of the Identify Pores dialog (see page 12). 

As mentioned above in GSD Field Choices, the option Load Grain-Size Distribution 

loads the Grain-Size Distribution file (*.gsd), that contains the 3D distributions of the 
grain properties chosen in the Results tab (page 24). Load Grain-Orientation 

Distribution loads the orientation distribution file (*.gof) of the grains found by the 
grain identification process. 
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THRESHOLDING RESULT 

The structure that contains the thresholded grain materials is loaded by clicking the 

Load Grain-Type Structure button. Here, either Load *.gdt or Load *.gad can be 
chosen. The options for the thresholding can be found in the Results tab as 

mentioned above in Thresholding. 

SHAPE-ANALYSIS RESULTS 

Several options for the analysis of the identified grain shapes are available in the 
Shape-Analysis Results panel. With Load Grain Fit Shapes, the best-fit shapes 

for the individual grains are imported into GeoDict as *.gad file and can be visualized.  

The option to Load Comparison of Segmented Grains and their Fits is closely 

related to Load Grain Fit Shapes. The identified grains and their best-fit shapes are 
both imported into GeoDict and shown as different materials (Original and Fit). This 
visualization is useful to check if the chosen best-fit shape type suits the grain 

structure. It is also a good indicator to evaluate the performance of GrainFind with 
the chosen options (compare the figure on page 11 for reference). 

With Load Euclidean Distance Transform per Grain, the results of the Euclidean 
Distance Transform for each grain can be imported if Save Euclidean Distance 
Transform per Pore as *.dst was previously checked under the Output Options 

tab of the Identify Pores dialog (see page 12). 

INTERMEDIATE RESULTS 

In the Intermediate Results panel, results from the identification steps can be 

loaded. 

With Load Grains from Step 1 (Result of Watershed), the segmented structure 
after the watershed transform is shown without any post-processing. Depending on 

the structure and the chosen Minimal Grain Diameter, this step might already 
suffice for identifying the grains. Otherwise, this option is useful for checking the 

initialization options – mainly if the Minimal Grain Diameter was chosen correctly 
for the investigated structure.  

By clicking Load Grains from Step 2 (Result of Grain Reconnection), the 

structure after the Grain-Fragment Reconnection is loaded in GeoDict. This way it can 
be investigated if the chosen value for the Interface Threshold suits the analyzed 

structure. This is only available if Reconnect Fragmented Grains was checked in 
the Grain Segmentation tab of the Identify Grains dialog (see page 9). 

Load Grains from Step 3 (Result of Boundary-Grain Removal) imports the 

structure after the steps defined in the Domain-Boundary options are evaluated. 
This is only available if Remove Grain Fragments at Domain Boundary was 

checked in the Grain Segmentation tab of the Identify Grain dialog (see page 10). 

For the visualization of the identified grains, remember that the visibility of all material 
IDs must be set to visible in Settings → Color & Visibility Settings → visible. The 

identified grains are assigned 15 random colors, which are unrelated to their size. The 
visibility of the pore space (ID 00) should remain unchecked and thus it will not be 

rendered.  
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CREATE VIDEOS  

With Create Videos, it is possible to automatically 
generate a video showing the largest identified 

grains compared to their fit shapes. During the 
creation, ExportGeo-CAD is used to create a 
smooth surface for the visualized grains. Note that 

a special license is required to use this feature. 
Alternatively, in the drop-down menu there is the 

option to choose the video generation without the 
module ExportGeo-CAD by choosing Identify 

Grains Video (Without CAD).  

Click Edit Parameters… to choose the number of 
grains that should appear in the video. Additionally, 

the video duration and the fontsize for the plot 
labels can be edited. 

Clicking the Create Video … button starts the creation of the video. When the video 
is finished, the video file is saved in the results folder belonging to the loaded *.gdr 
file. The result folder can be opened by right-clicking on the file name and path in the 

Result Viewer Header section box and choosing Open Result Folder. 
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CONNECTING GRAINFIND ANALYSIS RESULTS WITH GRAINGEO 

The results of a GrainFind run can be used to generate structures with similar 
properties in GrainGeo – a “digital twin” of the material can be created. Here, this 

procedure is shown with the structure used for the examples above. 

Start GrainGeo by selecting Model → GrainGeo in the menu bar and choose Create 

Grains from the pull-down menu. Click the Edit… button. In the upper right of the 

GrainGeo Create Options dialog, click Load GrainFind Result … and select a 
GeoDict result file (*.gdr) from a GrainFind run.  
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The data from the *.gdr file is now directly loaded into GrainGeo.  

In the figure below, the parameters directly imported from the GrainFind result are 
displayed under the Create Options tab and the Object Options tab in the 

GrainGeo Create Options dialog.  

The GrainFind results are automatically entered in the Domain parameters, the 

Generation and Overlap Mode (Overlap SVP in the options of Without 
(Remove) Object Overlap), and in the Solid Volume Percentage of the structure 
under the Create Options tab.  
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The identification analysis also automatically delivers the Material of the identified 

objects (for example, Calcite), the Diameter size and the Orientation parameters 
of the grains under the Object Options tab.  
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By clicking Generate in the GrainGeo section, a structure with the parameters 

obtained from GrainFind is created in GrainGeo. In the example below, on the left 
side the original structure (this structure is analyzed with GrainFind) and a structure 

based on the GrainFind parameters are shown.  

EXAMPLE: DIGITAL TWIN OF A 3D-SCAN 

With GrainFind and GrainGeo you can also create digital twins of large segmented 
scans, like the NMC cathode structure provided by the ETH Zurich, which can be 

seen below. For more details, please have a look at our tutorial “Building a Digital 
Twin of a cathode material with GrainFind and GrainGeo”. 

Original structure 

Structure created with GrainGeo 
and Load GrainFind results 

Segmented NMC cathode structure. Data provided by 
the Laboratory for Nanoelectronics, ETH Zurich.  

See M. Ebner et al., Tortuosity Anisotropy in Lithium‐
Ion Battery Electrodes, Advanced Energy Materials, 
Volume 4, Issue 5, April 2, 2014. This structure is also 
used in the GrainFind tutorial. 

Structure created with GrainGeo and "Load GrainFind 
Results" 

For more information, check the “Building a Digital Twin 
of a cathode material with GrainFind and GrainGeo” 
tutorial 

https://www.geodict.com/service-support/learning-opportunities/tutorials.html
https://www.geodict.com/service-support/learning-opportunities/tutorials.html
https://www.gddownload.de/Tutorials/GrainFindTutorial_Finding_a_digital_twin_of_a_Cathode_material.zip
https://www.gddownload.de/Tutorials/GrainFindTutorial_Finding_a_digital_twin_of_a_Cathode_material.zip
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IDENTIFY BINDER (AI) 

To use the Identify Binder (AI) functionality, a GrainFind-AI license is required. 

The separation between solid and pores of a structure can usually be done using 
image processing methods during the import of the scanned data sets (see the 

ImportGeo-Vol handbook of this User Guide for more details). However, the 
separation of binder from grains is often not possible since they have similar gray 

values in the scan. 

The structure shown here is a segment of sample of a NMC cathode structure from 
the Laboratory for Nanoelectronics, ETH Zurich (See page 32 for reference). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To start, select Analyze → GrainFind from the 

menu bar and, in the GrainFind section, select 

Identify Binder (AI) from the pull-down menu. 
Click the Options’ Edit... button. 

 

 

 

 

https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoVol&release=2023
https://geodict.com/fileadmin/script/UserGuide.php?lang=en&chapter=ImportGeoVol&release=2023
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BINDER IDENTIFICATION SETTINGS 

The Binder Identification dialog that opens includes the Binder Identification 
tab, the Solver Options tab and the Equations & References tab. 

At the top, enter the Result File Name (*.gdr) under which the results are saved 
in the chosen project folder. 

In the Binder Identification tab, two choices 
are available as Identification Mode: Use 
Current Structure and Load Neural Network Output.  

The default Use Current Structure applies the binder identification to the structure 
currently available in the GeoDict memory. This is the common use case for Identify 

Binder. 

The Material to Analyze panel offers the choice of whether GrainFind-Identify Binder 
(AI) should be applied to all solids in the structure or only on a subset, defined either 

by choosing a material or several material IDs. 

 

Next, select one of the neural networks available under Neural Network. Since 

GeoDict 2023, more than one neural network (.gnn stands for GeoDict neural network 
parameter file) will be provided, making it possible to select the best suitable one for 
the structure under consideration.  

 

In the Description, the current constraints for the application of the chosen neural 
network are listed, like the grain shape and size for that the neural network was 

trained. In order ensure that the grains in the present structure fit to the grains with 
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which the neural network was trained, it is recommended to use Estimate Grain 

Diameter before running the binder identification.  

On occasion, the user may want to change some parameters, without having to run 

the identification for each voxel with the neural network again and in that case, the 
option Load Neural Network Output may be very useful. 

 

 

Browse to a GeoDict result folder of a previous run of GrainFind-Identify Binder (AI)  
and select a nnOutput.npz file from that folder. Since already the output of the neural 
network is used in that case, no selection of Material to Analyze or Neural Network 

is possible and the currently loaded structure needs to be the same with which the 
neural network was trained. Otherwise an error message appears. 

 

The Threshold is an expert parameter: The neural network provides probabilities if 
a solid voxel is binder or not. The Threshold defines the limit for labelling a voxel as 

binder. It is recommended to keep the default value of 0.5, since this reflects the 
computed probabilities correctly. 

The Binder Material ID specifies the material ID to label the binder. The first unused 

material ID is used for the Binder Material. In the example below, the structure 
contains only material ID 00 and 01, thus the Binder Material ID is 02. To be able 

to distinguish the binder properly from the other materials, the color for this ID should 
be changed to a color different from the color of any solid or pore material present in 
the original structure after the identification has finished. This can be done under 

Settings → Color & Visibility Settings…. 
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Select one or several boxes on the Domain-Boundary Options panel if the 

underlying structure for the binder identification is periodic in one or more directions. 
However, periodicity is unusual for most 3-D scans and this setting is rarely changed. 

 

If a suitable graphics card is detected during installation of GeoDict, the GPU mode is 

used for running GrainFind-Identify Binder (AI), otherwise it is running in CPU mode. 
The version used is displayed on the Solver Options tab.   

 

The choice for Batch Size is related to the memory available on the graphics card 
(GPU). Conceptually, GrainFind-Identify Binder loads the graphics card with portions 

of work called batches. Currently, the selection must be made manually, and the 
parameter is set following the value entered in Batch Size.  

The batch size might be chosen too large for what is available on the graphics card. 

In this case, an error message appears.  

 

In this case, the number of batches needs to be reduced. Note that for CPU-based 
computation, the choice of batch size is not critical and can be left at the default. 

The default setting in GrainFind-Identify Binder for the Batch Size is 2, and it is 

recommended to keep this setting. 

The Equations & References tab provides information about the methods used 
during this command. The references can also be found at the end of this user guide 
in the chapter References. 
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BINDER IDENTIFICATION RESULTS 

After the successful binder identification, the GeoDict Result Viewer opens for the 
result file (.gdr). Under the Results - Report tab, the percentage of solid voxels 

identified as binder is shown.  

In the Results – Plots subtab, the Binder Distribution in the different Z-Layers is 
shown. 

To load the structure with identified binder, click Load *.gdt under the Binder 
Visualization tab.  
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In the 3D visualization, the distribution of binder between the grains is visible for the 

whole domain. 

 

The 2D view is useful to evaluate the result of the binder identification, as seen in 
the example below (left: without binder identification, right: with binder 
identification). 

 

 

Load the confidence field, by selecting Load *.npz under the Binder Visualization 
tab, i.e. the unsegmented result of the binder identification.  

 

The confidence field contains the probability for each voxel to be binder. In the figure 

below, the field is only visible for the solid materials and it is well visible where the 
neural network is confident of the choice and where it is uncertain: The dark blue 
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areas are clearly marked as grain, the red areas are clearly marked as binder, and 

the values in between (bright blue to orange) are uncertain. 
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ESTIMATE GRAIN DIAMETERS 

Estimate Grain Diameters gives an estimate of the grain sizes in the structure by 

fitting spheres into the structure and evaluating their diameters. The algorithm is 
faster than Identify Grains and it does not need any information about the single 

grains in the structure. In post-processing, different diameter classes can be 
identified, and the structure can be segmented with respect to them.  

For this part of the User Guide, an example 

structure created with GrainGeo is used and 
shown here.  

The algorithm behind Estimate Grain 
Diameters works as follows: At the start, each 
voxel gets assigned a Grain Diameter of 0. 

Then, spheres are successively fitted into the 
geometry, starting at the largest possible 

sphere. If a sphere fits and a voxel has no 
diameter assigned to it yet, the diameter of the 
fitting sphere is assigned to all voxels contained 

in the sphere. 

If a voxel is contained in multiple spheres, there 

are two options:  

1. The center of a smaller sphere lays inside a larger sphere. The diameter value of 
the larger sphere is assigned to all voxels in the smaller sphere (in the figures 
below, see a) red and blue spheres and b) all three spheres) 

2. The center of a smaller sphere does not lay inside a larger sphere. The 
overlapping area between both spheres is partitioned between both diameters (in 

the figures below, see a) red and green spheres)  
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This algorithm ensures that non-spherical grains get assigned the diameter of the 

largest inscribed sphere.  

In the figure below, the process of estimating the grain size is illustrated on the 

example structure shown above. On the left, the original structure (the material 
which is selected to be analyzed) is shown. In the next step (middle), the EDT (see 
page 3) is calculated to find the maximal fitting sphere at every point. On the right, 

the result of Estimate Grain Diameters is displayed. 

 

 

ESTIMATE GRAIN DIAMETERS OPTIONS 

After selecting Analyze → GrainFind from the menu bar, the GrainFind section 

opens on the left bottom of the GeoDict GUI. Select Estimate Grain Diameters 

from the pull-down menu and click the Edit… button. 

The default Result File Name can be kept or changed to a user-defined file name. 

 

 

Under Material to Analyze, the materials 

for which the grain size is estimated are 
chosen.  

 

 

The available options are All Solid Materials, Chosen Material, or Chosen 

Material IDs. The selected combination of materials (All Solid Materials or multiple 
material IDs) is analyzed as one. 

Original structure Euclidean Distance 

Transform (EDT) 

Estimated Grain Sizes 
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In the Domain-Boundary Options panel, the first option is to Remove Grain 

Fragments at Domain Boundary. A grain fragment in this context is a connected 
area with the same assigned diameter value.  

◼ Grain fragments at the boundary might corrupt the grain diameter estimation, 

since it cannot be known if the grains at the boundary lie completely in the 
domain or if they are cut at the domain boundary (compare the images 

below).  
◼ Nevertheless, removing the boundary grains also influences the diameter 

distribution: Larger grains have a higher probability to touch the boundary, 

and therefore also a higher probability to be removed. Thus, large grains 
might be underrepresented in the diameter distribution.  

The boundaries can have a critical influence on the results, and it must be 
carefully evaluated if Remove Fragments at Domain Boundary should be used 

or not. 



Estimate grain diameters 

GeoDict 2023 User Guide  43 

With the Periodicity option, the handling of the structure at the domain boundary 

can be defined. If a direction is chosen, periodic boundary conditions are applied in 
this direction. Otherwise, symmetric boundary conditions are applied. Periodicity 

should only be chosen if the corresponding real-world structure is periodic, too.  

This option is important to define the handling of boundary grains, since no 
information is available about the structure outside of the domain.  

All grain fragments with an assigned diameter value lower than the Minimal Grain 
Diameter are neglected. If they are connected to other grain fragments with a larger 

diameter value, the fragments are merged and get assigned the larger diameter 
value. If they are not connected to any other fragments, they are removed from the 
structure.  

In the figure below, the behavior of the algorithm can be observed: On the left, the 
Minimal Grain Diameter is set to 0 µm, so all grain fragments are kept independent 

of their assigned diameter. On the right, the Minimal Grain Diameter is set to 20 
µm and all fragments with an assigned diameter lower than 20 µm, which are not 
merged to larger grain fragments, are neglected. 

 

Since GeoDict 2020, the units of the Minimal Grain Diameter are meters or voxels. 

The latter is new since GeoDict 2020 and allowed us to set a better built-in default 
value for the Minimal Grain Diameter. 

The Bin Size is the step size between following sphere diameters, which are fitted 

in the structure. The choice of the Bin Size is important in post processing. It affects 
the results in the *.gdr file, e.g. the Inner Grain Diameter Histogram (see page 45). 

If it was not chosen as desired, the value for the Bin Size can be changed later 
during postprocessing in the Result Viewer of the result file (under the Results → 

Plots subtab). 
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GRAIN DIAMETER ESTIMATION RESULTS 

At the end of the estimations of grain diameter, the results are shown in the Result 
Viewer. Alternatively, they can be loaded at any time by opening the corresponding 

*.gdr-file in the project folder (File → Open Results (*.gdr)…).  

The Result Viewer shows several tabs, but only the Results and Data Visualization 
tabs are explained here in detail. The others contain results similar to those explained 

above for Identify Grains (refer page 16). 

The Results tab contains the Report, Plots and Map subtabs, which are strongly 

interconnected. The Report subtab shows the results from the grain type analysis 
and a table with the bins for the histogram. The Plots subtab shows a histogram of 
the estimated grain diameters. The Map subtab contains the resulting data from 

Estimate Grain Diameters. This data is the basis for the tables in the Report subtab 
and for the histogram in the Plots subtab. 

 

The three subtabs share the (collapsible and expandable) settings panel on the left, 
where the Bin Size, the Thresholding Method, and the Number of Grain Types 

can be chosen. Changing a value and clicking Apply immediately changes the results 
in the Map subtab, and therefore the tables in the Report subtab and the histogram 
in the Plots subtab. 
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Changing the Bin Size mainly effects the resolution of the histogram in the Plots 

tab. A too large Bin Size leads to a “blocky” histogram, while a too small Bin Size 
leads to a volatile and noisy histogram. The Bin Size should be chosen so that the 

histogram is smooth and detailed. The effect of the Bin Size on the histogram is 
illustrated in the two images below. 

 

If the chosen Number of Grain Types is 2 or 

higher, the estimated grain diameters are assigned 
to different diameter classes based on the selected 
Thresholding Method., The k-Means method, 

Otsu’s method, and a Manual input are available 
as thresholding methods. Based on these diameter 

classes, the structure can be segmented by clicking 
Grain Type Structure → Load *.gdt in the Data 

Visualization tab, as seen below. 
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Under the Data Visualization tab, the Grain Diameter Distribution and the 

Grain Type Structure (as explained above) can be loaded. Load the Grain 
Diameter Distribution to visualize and examine in detail the estimated grain 

diameters in the Visualization area of the GeoDict GUI.  

The workflow is as follows: To create images similar to those used for the illustration 
of the Domain-Boundary Options and for the Minimal Grain Diameter (see page 

42), click Data Visualization → Load GeoDict Size Distribution (*.gsd). Click 

OK in the pop-up window.  
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The structure is shown in the Visualization area of the GeoDict GUI with the default 

visualization settings and a message appears indicating that the visibility of the 
structure will be turned off (unless the user clicks No). Click Yes. 

 

The visualization of the structure can also be turned off by unchecking the Structure 
tab in the Visualization panel above the Visualization area.  

 

Next, in the Volume Field tab of the Visualization panel, check that No 
Interpolation is selected and Smooth is unchecked for Threshold By. Finally, if 

needed, use the slider for the threshold to select the grain diameters that should be 
displayed. Here all grain diameters are displayed by setting the Diameter to zero 

and the mode to >=. 
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